THE BEST OF
Macworld MAC
SECRETS
New Edition

The Best Tips, Tricks, & Secrets to Get the Most from Your Mac & Power Mac

By David Pogue
Macworld Magazine's "Desktop Critic"

& Joseph Schorr
Macworld Magazine's Contributing Writer

IDG BOOKS
Dear Macworld Subscriber,

We’re happy to present you with the “Best of” Macworld Mac & Power Mac SECRETS. Here you’ll find some of the most interesting, unusual and useful morsels from the actual book. Some…but, alas, not all!

If you’d like to get your hands on the remaining 1,060 pages of Mac & Power Mac SECRETS plus 9MB of FREE software, you can! All at the discount subscriber rate of just $33.95.

Don’t wait! To take advantage of this special offer, simply return the order form located on the back page.

Happy reading!

David Pogue & Joseph Schorr
Authors
The Best of Macworld Mac SECRETS™

by David Pogue and Joseph Schorr
Introduction

What You Have Here

We'll bet you already know that you discard a file by moving its icon to the Trash can, that you select text by dragging across it, and that you end the day by choosing the Shut Down command. The world doesn't need another book to define scroll bar.

So when we started writing, we worked from one simple, overarching concept: Under no circumstances would we define scroll bar.

Instead, we decided to tell secrets: secrets about how a Mac really works. Secrets that programmers buried in their software but forgot to tell the manual writer. All those elusive ⌘-Option-Shift-Tab-Question Mark key sequences that are whispered at little-known user groups...the little animated surprises that lurk inside commercial programs...the trick to connecting two Macs together with phone wire or making your icons invisible to prying eyes...at last, it's all been collected into one substantial paperback written by a couple of former college roommates.

It's called Macworld Mac & Power Mac SECRETS, 2nd Edition. You've got 64 pages of it in your hands. We've given you some of the most interesting, unusual, and useful morsels from the actual book, and we've tried to maintain its flavor, its humor, and its look.

What You Don't Have Here

Of course, this 64-page booklet leaves out something rather important: the other 1,040 pages of Mac & Power Mac SECRETS!
In other words, you're missing our special coverage of PowerBooks, Performas, fonts and printing, CD-ROMs, the top 15 application programs, System 7.5, Word 6, QuickDraw GX, networking, Remote Access, and so on.

Actually, this "Best of SECRETS" sampler omits one other rather important element of the real book: nine megabytes of free software. Much of it is commercial software from actual software companies. Real, working, non-demo, non-time-limited software. You get something great without having to pay for it. They hope you'll like the stuff so much you'll buy more of their software. ($600 in discount coupons are at the back of the real book, too.)

Here are just a few of the 40 programs that come with Mac & Power Mac SECRETS:

<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bitstream Fonts</td>
<td>TrueType fonts from Bitstream.</td>
</tr>
<tr>
<td>Color Coordinator</td>
<td>Change your screen's Monitors color setting simply by pressing a key — or automatically by application. From Casady &amp; Greene.</td>
</tr>
<tr>
<td>Color It!</td>
<td>A powerful commercial 24-bit painting and retouching program. Requires only half the memory of Photoshop. From MicroFrontier.</td>
</tr>
<tr>
<td>CP Undelete</td>
<td>Recover recently deleted files, even after you empty the Trash. From MacTools Deluxe (Central Point Software).</td>
</tr>
<tr>
<td>DiskTop</td>
<td>The powerhouse file-management desk accessory; the Finder in a DA. From PrairieSoft.</td>
</tr>
<tr>
<td>Kaboom! sounds</td>
<td>Saucy, sassy sound files from the award-winning Kaboom! collection. From Nova Development.</td>
</tr>
<tr>
<td><strong>Label Secrets</strong></td>
<td>Each time you turn on your Mac, the Label menu displays a different Macintosh Secret from the book. Exclusive!</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Power to Go</strong></td>
<td>Three modules for controlling the cursor, battery savings, and screen dimming of your PowerBook. From Claris Clear Choice.</td>
</tr>
<tr>
<td><strong>QuickDEX</strong></td>
<td>The classic, lightning-fast address book and phone dialer desk accessory. From Casady &amp; Greene.</td>
</tr>
<tr>
<td><strong>ResEdit</strong></td>
<td>The Mac’s famous resource editor. Lets you examine and edit alert messages, command key equivalents, icons, and much more. Licensed from Apple Computer.</td>
</tr>
<tr>
<td><strong>Speed Disk</strong></td>
<td>The fast, safe, intelligent hard-disk defragmenter and optimizer, for safety and speed. From Symantec; part of Norton Utilities.</td>
</tr>
<tr>
<td><strong>TempoEZ</strong></td>
<td>A commercial macro utility from Affinity. A macro is a chain of tasks that your Mac performs automatically when you press a single key.</td>
</tr>
<tr>
<td><strong>WYSIWYG Menus</strong></td>
<td>Displays fonts in their own typefaces (in the menus), unites font families, lets you choose font sets for each program, and more. Commercial software from Now Software, part of Now Utilities.</td>
</tr>
<tr>
<td><strong>Zterm</strong></td>
<td><em>Macworld</em> World-Class Award-winning telecommunications program. Use it to dial up friends or local BBS services with your modem.</td>
</tr>
</tbody>
</table>
Even without the other 1,040 pages and the three disks, though, we've tried to cram enough good stuff into this little collection to make it fun reading. Here's hoping it gives your Mac a turbocharge—at least until you get your hands on the real book!

About the Authors

Ohio-bred, Yale-educated, Manhattanite David Pogue is the author of the #1 Mac bestseller *Macs For Dummies* (IDG Books Worldwide, 15 printings, 15 languages) and its inevitable sequel, *More Macs For Dummies*. He writes the monthly Desktop Critic column in *Macworld*. His Mac students include Stephen Sondheim, Carly Simon, Mike Nichols, Gay Talese, and Mia Farrow.

Joseph Schorr is a journalist and playwright who contributes regularly to both *Macworld* and *MacUser*. A 1985 graduate of Yale University, he is currently the editorial production manager of a Mac-based publishing company in Eugene, Oregon. His plays have been produced at Yale, Off-Off Broadway, and at Wolf Trap.
Most people don’t immediately think of the Finder as a program. After all, you don’t double-click an icon to launch it, as you would with, say, ClarisWorks. The Finder is just always there, waiting as your home base, whenever you exit your other programs.

Nonetheless, the Finder is a program. It’s responsible for displaying your familiar startup world: the Trash can, icons, folders, and the gray backdrop.

### Finder Secrets

**A really amazing re-alphabetizing Secret**

Over and over again, in books and magazines, you’re told to put spaces in front of your icons’ names if you want them to rise to the top of an alphabetical list. For example, a file called Zebra will come before one called Aardvark, as long as you put a space in front of the Z.

Trouble is, you can see those spaces. Your icons’ names look stranger and stranger, the more spaces you put in front of the actual names. Here’s a much better way.

Open the Note Pad. Press Return, thus creating a blank line. Select the blank line and copy it. Now click the name of an icon in readiness for renaming it. Press the left arrow key to move the cursor to the beginning of the name.

Now paste that invisible Return character you copied. The existing name disappears, but don’t worry; just press Enter, and it returns.
Incredibly, your renamed file now appears first in any alphabetical file list, but it doesn’t look any different!

Furthermore, a file with two blank Returns at the beginning of its name comes before one with only one; a file with three appears even before that...and so on.

_Techie Note:_ This works because the Return character is early in the ASCII character set. If you’re clever, you can paste in even earlier characters — such as ASCII character #1, which you make by pressing Control-A (in Key Caps), for example.

**SECRETS exclusive: Recovering trashed files**

Once you’ve thrown files away by accident and emptied the Trash, your best hope for recovering them is Norton Utilities. But what if you’re stranded on a desolate island (or desolate hotel room) and you don’t have your Norton disks? Believe it or not, this System 7 trick lets you recover recently trashed files without a recovery program.

Here’s the secret: As soon as you empty the Trash — and realize you just dumped something you shouldn’t have — pull the plug. (Or switch the Mac off; or press the Reset switch; or remove the PowerBook’s battery.) Don’t perform any other commands. Don’t use Shut Down. Don’t restart.

Then start up again. When your desktop appears, you’ll find that your most recently trashed items have miraculously returned from the dead! They may even be back in their original folders or desktop positions, just as if they’d never been deleted.

**Replace an icon**

In System 7, you can create your own icons for any file, folder, or disk. Here’s how. First, highlight the icon you want to replace. From the File menu, choose Get Info. The Get Info box appears for the icon you
The deadliest file name

Don’t name any file .Sony. Doing so will trash your hard drive!

When we first heard this, we hooted with sinister glee. How anti-Sony was the Mac programmer who planted that little trap into the Mac operating system?

Turns out there’s nothing so evil going on. Instead, .Sony is the name of the invisible floppy disk driver, the software that controls your floppy drive! If you give a file that name, the Mac may try to address it as though it’s a floppy drive. All kinds of hard drive corruption will result.

So much for user-friendly.

selected. Press Tab; choose Copy from the Edit menu to copy this original icon to the Clipboard.

To customize the icon, paste it into any painting program, from HyperCard to Photoshop. Now, using the painting tools, create a replacement icon. Try not to paint an icon larger than the size of a real icon.

When you’re done, copy the new icon. Go back to the original icon’s Get Info box, press Tab, and paste the replacement. That’s it!

Electronic Post-it notes…and hidden icons

Use the previous tip to replace a folder’s icon with a plain white square copied from a graphics program. You’ve just made the folder disappear.
You can use this idea for all kinds of interesting effects. For example, you can duplicate this doctored folder endlessly. Just make sure that you give each copy a new folder name, such as *Meet Tracy at noon today*. Then leave these notes strewn about your desktop as little reminders.

Extra bonus trick for privacy: after replacing a file’s icon with a white square, change the file’s name to a couple of blank spaces (tap the Space bar). The result: your file is completely invisible in any Finder window!

**Quick access to the Apple menu**

As you probably know, any icon you place in the Apple Menu Items folder is instantly listed in your Apple menu. Trouble is, the Apple Menu Items folder isn’t very convenient, nested as it is inside the System folder.

If you frequently add or remove things from your Apple menu — and using the Apple menu as a launch pad for your current crop of files is a smart idea — make an alias of the Apple Menu Items folder. Leave the folder out on your desktop.

To add something to your Apple menu, just drop it on top of this folder alias. To remove something, double-click the folder alias and drag the item out of the window.

**Quick access to the Apple menu II**

The previous Secret works wonderfully, but it also leaves a big clunky folder out on your desktop. Here’s a subtler technique.
Follow the steps in the previous trick. Instead of leaving the image of the folder alias out on your desktop, make the icon itself invisible (see the Secret called “Electronic Post-It notes... and hidden icons”). Replace the name of the folder alias with a few blank spaces.

The result is an iconless folder with no name — a white rectangular slot. Click the rectangle and drag it just under your Apple menu, as shown here.

Then, whenever you want to add an item to the Apple menu, just drag it over and pop it in the slot (the white rectangle). Anything you slip into it instantly disappears and reappears in the Apple menu.

When you want to remove or rename something in the Apple menu, double-click the little slot itself. The Apple Menu Items folder opens.

**Express Erase Disk command**

If you hold down the ⌘, Option, and Tab keys while inserting a disk into your Mac’s floppy drive, the Erase Disk command will be activated automatically. You’ll see the standard dialog box asking if you want to erase the disk. Press Return and the erasing begins.

**Sort and neaten windows simultaneously**

This is a really useful Secret. If you press Option, the Clean Up command (Special menu) says Clean Up by Name (or Size, or Date, and so on). The sorting method is determined by the sort method you used the last time the window was displayed in a list view. The command makes icons snap to a grid, just as the normal Clean Up command does. But instead of moving each icon to the
nearest grid position (and leaving gaps), this command places them neatly, one after another, in sequential rows at the upper-left of the window. If you’re viewing by Small Icon, your files fall neatly into columns.

Hint: Since this special version of Clean Up puts icons side-by-side in rows so that they precisely fill up the window they’re in, adjust the window’s size before using this command.

Visit scenic Silicon Valley
If you press Option as you choose the first command in the Apple menu, the wording changes to say About the Finder, and you see a rustic moonlit picture of a valley—presumably the “silicon” one in which Cupertino (Apple’s headquarters) sits.

And if you press ⌘ and Option as you choose About the Finder, you get both a scenic moonlit scene and a cursor with an attitude. (Wait patiently to view the scrolling credits, too.)

Cut, Copy, Paste, Clear
It may not occur to you to use the Cut, Copy, Paste, and Clear commands in the Finder, where there’s really no text or graphics to work with. But these commands do work in a surprising number of different Finder contexts.

- Select a group of icons. The Copy command, believe it or not, grabs all the icons’ names (up to 255 characters). Here’s a handy trick—open up a word processor and paste. You’ve just made yourself an instant list of a folder’s contents.

- Open the scrapbook. All of the Edit commands work to transfer pictures, sounds, QuickTime movie clips, or text.
Open the Puzzle or Jigsaw Puzzle desk accessory. The Edit commands copy and paste graphics into the puzzle itself. The same thing works with the Map control panel.

Open the Sound control panel. You can select a sound’s name and copy the sound, clear it, or cut it. If a sound is already on the Clipboard, you can paste it in.

TRUE FACT

Finder Unlimited?
The Finder has a few built-in limits. But you’ve got to be a serious mega-user to reach these numbers:

- Maximum number of open files on your Macintosh at once: 346
- Maximum number of Apple Menu Items: 50
- Maximum number of applications running: No built-in limit (except how much memory your Macintosh has)
- Maximum number of volumes (disks) available at once on the Desktop: 32
- Maximum number of sounds, fonts, and keyboard layouts installed in the System File: 32,767 or 16 megabytes
- Maximum memory you can allocate to a program: 99,999K
- Maximum number of colors in an icon: 256, even on a Mac with 24-bit color
- Maximum disk cache: 1/4 of physical RAM
- Maximum number of files on a disk: 65,536
- Maximum number of nested folders: 64
- Maximum number of items in a folder by list view: Up to 32,000 depending on the computer and RAM. (But, according to Apple: “Attempting to view large amounts of data in one window, something in the range of 500-1500 files, will create very slow opening times and drop-out viewing problems. The specific number depends on RAM and CPU.”)
Chapter 2

Control Panels and DAs

You thought System 7 was bad? Now you can enjoy System 7.5, for which a full installation scarfs down more than 20MB of your hard drive. That includes nearly 100 control panels, extensions, and desk accessories, creaking with secrets and hidden features; here are a few.

Desk-Accessory Secrets

AppleCD Audio Player

One of the nice aspects of owning a CD-ROM player has always been that it can double as a music CD player. You can crunch numbers to the strains of Carly Simon. Over the years, Apple has continually refined the desk accessory used to control the audio CD.
The latest, AppleCD Audio Player, actually allows you to rearrange the tracks, repeat them, or leave the irritating songs out of your listening order.

To do so, click the tiny triangle (at the left side of the window) to expand the panel, as shown in the figure. If the songs aren't already named, click the NORMAL button, click the first track name, and begin typing the song titles (press Return after each title to move down). While you're at it, click the words Audio CD and type the name of the disc, too. After you do all this, the Player automatically remembers the titles the next time you insert the disc. (How does it do that?)

Finally, click the PROG button. Now you can drag any title on the left side to any slot on the right side (as shown in the figure). You also can drag titles up or down on the right side. Feel free to drag the same song twice or to leave songs out of the play list on the right side.

**Calculator: Copy-and-Paste madness**

With the four-function Calculator, you can add, subtract, multiply, and divide numbers of up to 13 digits. You can enter numbers by typing them on the keyboard or by clicking the calculator buttons.

The Calculator's worst feature is that it has no CE button to clear only the last entry. If you inadvertently enter a wrong number, you have no choice but to click C (Clear) and begin the entire calculation anew.

For this reason, we recommend always typing your equation in the Note Pad desk accessory, such as 123–44*16/2=, and then copying it. (In computerese, * means times, and / means divided by.) Then open the Calculator and choose Paste from the Edit menu; the on-screen keys flash madly, as though they're being punched by a ghost, and the Calculator instantly computes the answer. (You can then copy and paste the answer into any document.)
**Calculator: the scientific-notation keystroke**
Press the E key when using the Calculator, and your calculations appear in scientific notation! Now the Calculator can work with bigger numbers.

**Calculator: the secret one-pixel handle**
The Calculator has a hidden handle. It's a safety handle that lets you move the Calculator clear off your desktop — where it will still work, albeit invisibly, when you press your number keys.

This hidden pixel is in the lower-left corner, where the curve joins the vertical. It's the only spot on the Calculator that's draggable (other than the title bar).

---

**Puzzle: Make your own**
You can replace the Puzzle's Apple logo with the picture of your choice. Copy the graphic you want to turn into a puzzle, open the Puzzle or the Jigsaw Puzzle, and choose Paste from the Edit menu. Your graphic automatically is sliced into pieces and scrambled.
**MACINTOSH SECRET**

**A panel-free Mac**

It seems unbelievable, but you don’t need any control panels to run your Mac. You can change your preferences with the Control Panels. The preferences themselves, however, are not stored in the control panels but in your Mac’s PRAM (a tiny piece of memory permanently sustained by your Mac’s built-in lithium battery). After you pick a Desktop pattern and decide how fast you like to double-click your mouse, or choose a color for highlighted text, or pick an alert sound, you can drag all your control panels to the Trash, clearing at least several hundred K out of your System folder. (If you have a 2-gig hard drive, you might not care about a few hundred kilobytes, but if you have a PowerBook with a 40MB hard drive, those Ks add up.)

If you do decide to trash your control panels, store them on a floppy disk. If you need to change any of your preferences later, just insert the floppy disk and open the appropriate control panel (no need to install it or to restart the machine).

---

**Puzzle: The Puzzle nobody knows**

Incredibly, you can edit the numbers in the original Puzzle, change the font or size, or change the numbers altogether! Here’s the Secret.

If the Apple logo puzzle is displayed, choose Clear from the Edit menu to switch to the number tiles. Then choose Copy from the File menu.

Now open an object-oriented drawing program (MacDraw, Canvas, Word’s graphics window, and so on), and paste what you copied. Regardless of how scrambled the numbers were, they now appear in the correct order.

In your graphics program, each number and each gridline appears with its own handles as an individually movable graphic object. (Click a blank white area to deselect all the handles, and you’ll see what we mean.)
You can change the font or size of the numbers, change them to letters of the alphabet, or whatever — but put everything back in the original grid when you're finished playing. Finally, copy the whole numbers graphic again and paste it back into the Puzzle.

**Puzzle: A really devious trick**

Here's a great way to humble hotshots: change the order of the numbers. Use the previous Secret to paste the Puzzle numbers into a graphics program; then drag the numbers around. Try switching the 4 and 7, for example.

When you finish, the number-tile puzzle looks the same, but the numbers will be scrambled. Your Mac now thinks that the wrong order is the right order! Your victims will never hear the triumphant "Ta-da!" reward that comes with solving the puzzle. They can't win!

**Control-Panel Secrets**

*The Map control panel: basics*

If you need to know the exact time in Ulan Bator (a city in northern Mongolia), or if you're called upon to calculate the mileage from there to your office, the Map control panel is indispensable.

Click any spot on the world map, and the Map displays the current time at that locale, along with its precise longitude and latitude. You can scroll around the world by dragging the pointer to the edges of the map window.

The Find feature locates specific cities, islands, and other points on the Map; just type the name of the city you want to locate and then click the Find button (or press Return). The Map already knows about most
major cities, as well as Mount Everest (and surprising other spots — try typing MID and pressing Return).

**Map: the cities in order**
To see all the locations that the Map already knows about, hold down the Option key while repeatedly clicking Find (or pressing Return). If you continue past Zürich, the Map starts at the top of its list again — but this time, it tells you each city’s name *in the native language spoken there!*

**Map: convenience for the PowerBook traveler**
If you travel with a PowerBook to a different time zone, reset the Map’s home city when you go on a trip. (Find the city on the map, then click Set.) By resetting the map to the city you’re visiting, the time on the Mac’s internal clock automatically changes to match the new time zone. This way, you don’t have to set your Mac clock at the end of each flight.

**Map: zooming in**
You can view the map at three levels of magnification: normal size, twice normal size, and four times normal size.

Magnify the map by 200 percent by pressing the Shift key while opening the Map control panel. To do this, you need to first double-click the Map icon and *then* press the Shift key (an icon won’t open if you hold down the Shift key *while* double-clicking).

To magnify the map by 400 percent, hold down the Option key while opening the control panel. For an even more magnified view, try opening the Map while pressing both the Option *and* Shift keys. (Again, you need to press Shift right *after* you double-click.)
Map: Get into color

If you have a color or gray-scale Mac, you can replace the uninspiring black-and-white map in the Map control panel with the splendid color world map stored in the Scrapbook. To make the switch, copy the color map from the Scrapbook. Open the Map control Panel, click the map picture, and choose the Paste command.

Actually, you can paste any graphic into the Map, although few choices other than a world map make any sense.

Map: What's the time in Tokyo?

You can find out the time difference between any spot in the world and your own time zone. First, click somewhere on the map (or type the city name, such as Paris, and click Find). Then click the words Time Zone. The Time Diff. box now shows the time difference between the cities. (The tiny + or – symbol at the right indicates whether you're ahead or behind.)
Sound control panel: How to rename a sound
You may think that there's no way to rename a sound after you record it. Not so — here's how.

In the Sound control panel, select the sound that you want to rename. Remove it from the list, using the Cut command (Edit menu). Next, use the Paste command (or press ⌘-V) to paste the sound back into your list. When you do so, you're asked to give the sound a name.

Type a new name and click OK.

Sound: What happened to my beep!?
It happens to everybody sooner or later: your system's error beep changes. Instead of having that charming, rich, bulbous sound, it suddenly turns into a glassy ping with much less character.

It's a feature, not a bug: you or someone you love has installed the new Sound Manager software, the invisible driver that controls sound on your Mac. This event also may be marked by a change in your Sound control panel; when you get the new panel, you also get the new ping. And of course, every new Mac and System from Apple since late 1993 comes with the new Sound Manager preinstalled.

Unfortunately, the cute little error beep isn't the only casualty of the new sound driver; the sound and music on many games and CD-ROM discs stop working, too.
Chapter 3

Starting and Restarting

Mac lore is filled with tales of little-known stunts your computer performs if you press certain mysterious key combinations while the computer is starting up. Here, together at last, are all the different key combos you can hold down as your Mac starts up, and what they do. We threw in a couple of other secrets, too.

Startup Secrets

The Shift-key-at-startup trick

Here's the complete story on the Shift-key trick. Hold down your Shift key, beginning no later than the appearance of the smiling-Macintosh icon. Release it when you see the words "Extensions off." You've just started up the Mac without any extensions or control panels. You also prevented anything in the Startup Items folder from launching and prevented file sharing from turning on.

You also made some changes to the Memory control-panel settings: you set the Disk Cache to 32K and turned off virtual memory and your RAM disk.

If you wait to press Shift until after your extension icons have finished appearing on the screen — but before the desktop appears — then you merely squelch the launching of the Startup Items folder's contents without turning off your extensions.
Rebuild the invisible Desktop file

There's an invisible Desktop file on every disk. Over time, the Desktop file may become bloated with icons belonging to files and programs you've long since taken off your disk.

To make the Mac "forget" all superfluous icons (and all Get Info comments) from your current Desktop file, press and hold the ⌘ and Option keys when the Mac is starting up. You don't need to press them until the "Welcome to Macintosh" message appears (or even until after your extensions have all loaded). You can let go of the keys when the Mac asks you specifically if you want to rebuild the Desktop file.

If you click OK, the Mac takes a minute or so to cleanse its Desktop file, resulting in a slimmer, quicker, invisible database — plus fewer system crashes, faster file opening, and generally smoother Mac operation.

Rebuild without restarting

As described previously, you have to restart the Mac to rebuild the Desktop file, right?

Not so. For this System 7 stunt, quit any programs you're running — except the Finder. Then press ⌘-Option-Esc. Your Mac will ask you if you're sure you want to force quit the Finder. (See? We told you the Finder is a regular, card-carrying application!)

Yes, you're sure. Click Force Quit and then immediately press the rebuild-the-Desktop keys, ⌘ and Option. The Finder relaunches itself and, because you're pressing those magic keys, it asks if you want to rebuild the Desktop. You do.

Start up to a neat, uncluttered desktop

There's no end to the secret key combinations that do things when you start up the machine. Press Option,
Example, if you want to be greeted by a clean, neat desktop, with no windows or folders open. Normally, the Mac always reopens whatever windows were open when you last shut down. Technically, you need to press Option only at the end of the startup process— from the end of the extension-loading phase to the appearance of the Trash can, for example.

**Zap the PRAM**

Your Mac has a tiny chunk of memory called parameter RAM or PRAM. This smidgen of memory is where the Mac stores settings it's supposed to retain when the computer is turned off (mouse speed, keyboard settings, and so on).
In times of trouble, you may need to flush this bit of RAM and start over. To do this with System 7, use another hidden key combination at startup: ⌘, Option, letter P, and letter R keys. Keep them pressed until you hear a second startup chime.

Then use your control panels to reset your settings.

**Bypass internal drive**

If, just after you turn on the Mac, you hold down ⌘, Option, Shift, and the Delete key, your Mac completely ignores its internal hard drive (if any). This is a good way to force your Mac to use a different startup disk, such as an external hard drive that you loaded with a different System version. (This is also a good way to sprain your hand.)
Use the TV for a monitor

Hold down ⌘-Option-T-V during startup to make a Quadra AV use an attached TV as a monitor.

Startup movies

If you have the QuickTime extension installed, there’s a special treat in store. You can designate a particular QuickTime movie to play in the middle of your screen when you start up the Mac!

To do this, rename the movie Startup Movie. Put it loose in your System folder. Then restart the Mac and watch (and listen to) the fun!

Reset-Switch Secrets

Where is it?

What it’s called is the Reset switch. What it does is restart the Mac. Every Mac model has a pair of these funny little switches: the Interrupt switch (marked by a dot) and its twin, Reset (marked by a triangle).

Start by figuring out where your switches are. On older Macs, it’s a piece of plastic you were supposed to attach to the inside or outside of the case. More recent desktop Macs have special buttons for the Interrupt and Reset functions; on the front of the 7100, 8100, most Quads — and on the back of the Centris (Quadra) 610 and 6100.

If you have a PowerBook 140 through 180, your switches are two tiny holes on the back panel (behind the flap). You “push the button” by inserting a straightened paper clip into one of these holes.

Virtually all other Macs have hidden Reset and Interrupt switches: press ⌘, Control, and the power button all at the same time. (That’s Reset. For the Interrupt function, it’s ⌘-power button.)
The programmer's switches in times of crisis

The Reset and Interrupt switches are great for two important reasons. First, when your Mac has hung or crashed, you can't do anything except restart it. Restarting by pressing the Reset switch is much better for the circuitry than turning the power off and then on again; it also takes less time.

Second, if you're really lucky, you may actually be able to undo the system crash. Press the Interrupt switch (the half of the programmer-switch pair marked by a dot). A special empty dialog box appears on the screen, containing nothing but a > symbol. Here are the various things you can type at this point, and what they're supposed to do.

G FINDER (then press Return) is supposed to get you back to the Finder safely.

SM0A9F4 (then press Return) PCFA700 (Return, again) G (Return, again) is another Return-to-Finder sequence. Those are zeros, by the way, not letter Os.

SM A78 3F3C 0002 A895 (press Return, then) G A78 (and another Return) shuts down your Mac.

These codes only sometimes work. On the other hand, when the system crashes and we've got important unsaved work on the screen, we'd jump up and down and say "gigabyte" ten times backward if we thought it would help.
Your hard drive is filled with lots of hidden goings-on and invisible files. Every time you save, copy, or delete a file, all kinds of stressful activities take place. More than just one file is affected; the hard drive must update its internal table of contents (the invisible Desktop DF file), log any new icons or icon positions (the invisible Desktop DB file), and keep track of how the file is fragmented (in the invisible extents file).

Here, for the careful Mac user, is our recommended schedule for hard-drive maintenance. Photocopy, clip, and save it.

**When you get the drive**

Format it using whatever drive-formatting program came with the drive. (If it's an Apple drive, it's already been formatted with the Apple HD SC Setup program.)

**When you change System software versions**

Before installing the new System, run Norton Utilities or Disk First Aid (on your System disks) to make sure the disk's software structures are healthy.
**Every day**

Back up whatever files you worked on during the day. If it’s important work, make two backups, and back up more than once a day.

**Once a month**

Rebuild the desktop file (press ⌘-Option as the Mac is starting up).

**Every three months**

Reinstall a fresh copy of the System software. Do a “clean install,” as described at the end of this booklet. (This eliminates any corruption that may have crept into your System file during day-to-day use.)

**Every six months**

Defragment your drive if it’s more than 80 percent full, using a program like Speed Disk (part of Norton Utilities).

**Every two years**

Back up your entire drive and reformat it. Among other things, reformatting locks out bad sectors on your disk, so you won’t try writing data to portions of the disk that have developed tiny flaws and may not be reliable. Beyond that, we just like the feeling of wiping out any lurking problems that may have wiggled into existence.

**The best hard-drive Secret ever**

If you’re completely cramped for space on your only hard drive, you’ll love this Secret. It unlocks several megabytes of storage space you never knew you had.
This procedure, however, involves erasing your entire drive. You must back up every file before doing this procedure, and then copy them all back to the hard drive when you’re done. It’s a pain, but it really may be worth the trouble. (For obscure technical reasons, don’t do this on a PowerBook with a 120MB drive.)

Here’s the Secret: An Apple factory-formatted hard drive contains several megabytes of unallocated free space. It’s completely wasted space; it’s not used by the driver software and can’t be accessed to store files. On one 80MB drive we looked at, only 78.1MB were partitioned for storage. Another 5.7MB were unallocated and inaccessible. (Yes, we know this adds up to 83.8MB; the 80MB designation is an approximation. Most drive manufacturers throw in a little extra storage space to compensate for bad blocks that may develop on the drive through normal use.)

You can use the HD SC Setup program, which comes on your System disks, to repartition the drive and unlock the extra space. Launch the program, click Partition, and then click Custom. This opens a window displaying all the partitions on the drive. The gray area near the bottom of the partitioning window represents the unallocated space on the drive. In the figure below, you can see that there’s plenty of unused free space — 5.7MB’s worth — on this 80MB hard drive.
Click anywhere on the main storage partition (the one called PogueBook in the figure above) to select it, and then click Remove to delete it.

Finally, drag in the gray area to create a brand new partition bigger than the original — one that makes use of all, or almost all, of the extra space available. When you’re finished, click Done.

Sure enough, when you copy all your files back onto the hard drive, you’ll discover that you have several additional megs to play with.

Floppy Disk Secrets

Ejecting a disk

The most obvious, though not the easiest, way to eject a disk from a floppy drive is to select its icon and then choose Eject Disk from the Special menu in the Finder.

We strongly discourage using this approach for two reasons: (1) Pulling down a menu is too much trouble, and (2) the Eject Disk command leaves a ghosted image of the disk on your Mac’s desktop. If you try to drag the phantom icon into the Trash, you may be asked to reinsert the disk you just ejected!

Better ideas:

- Drag the disk icon straight into the Trash. The disk pops out of the drive and its icon disappears.
- Under System 7, select the disk icon. Use the File menu’s Put Away command or, better yet, the ⌘-Y keyboard shortcut.

De-bloat a floppy disk

The invisible Desktop file on a high-density floppy disk is generally between 1K and 7K. If you have an empty floppy disk whose window header says 13K in disk,
your first (and correct) guess should be that its Desktop file is bloated.

But rebuilding the desktop in System 7 doesn’t restore a floppy disk to its native “1K in disk” status. Because of an obscure bug in the Finder, you need to use this goofy tip: create a new empty folder on the disk. Then rebuild the Desktop and throw away the folder. Somehow, having a folder or file on the disk when the Desktop is rebuilt unlocks the excess kilobytes.

Finding the Secret floppy message
Here’s a Secret we guarantee you’ll never stumble across by accident — it’s too weird. Insert a floppy disk and rename it either KMEG JJ KS or Hello world JS N A DTP.

Now eject the disk using -E. This leaves the ghosted disk icon on the desktop. Double-click on the icon and — surprise — the resulting “please insert the disk” dialog box displays the line: “HFS for 7.0 by dnf and ksct.”

As you may have guessed, dnf is David N. Feldman and ksct is Kenny S. C. Tung. David and Kenny are the Apple programmers who developed extensions to the Mac’s Hierarchical File System for System 7, and this is their moment in the limelight.

Why can’t I eject my SyQuest cartridge?
There’s a famous bug involving removable cartridges and System 7 file sharing. You can’t remove a removable if it was in the drive when file sharing started up.

Here’s a couple of solutions. First, you can wait to insert the cartridge until after file sharing has started up. Second, you can turn file sharing off while you eject the disk.

Third, you can use the shareware program called File Sharing Improvement Doohickey’s, which quickly turns File Sharing off and on again when you eject a cartridge.
Chapter 5
Macs & Power Macs

If this was the complete, 1,100-page SECRETS book, you'd find our devastatingly complete Chapter 11, which describes the circuitry, spirit, and secrets of every Mac model ever made. Under the circumstances, please accept these fascinating morsels by way of example.

Miscellaneous Hardware Secrets

Explaining the shadow line
Many Apple color monitors, including most 14" models, have a dark thin line that runs horizontally across the screen about two inches from the bottom. Don't bother returning your monitor — it's supposed to be there. (The larger Apple monitors have two lines.)

Turns out that these monitors are actually Sony Trinitron picture tubes. The design calls for a wire inside the picture tube to stabilize the colormask grid (an array of vertical wires that helps the electron beam strike only the correct spots on the phosphor). Despite this shade effect, says Apple, there's no better monitor technology available.

The LCIII, Duo, and 540c color miracle
The LC III (and Performa 450/460 series) comes with 512K of video memory. That's enough RAM to show 256 colors on most Apple monitors.
Like such other Macs as the Duo 270c and the PowerBook 540c, however, this model has a unique feature: it can also dedicate that same VRAM to giving you more realistic color at the expense of screen size. That means that you can have 16-bit color approaching photo-realistic if you’re willing to work with a smaller picture-tube area.

Here’s how. Open your Monitors control panel and click Options. You’ll see two choices: Macintosh Hi-Res Display and 640 by 400 Hi-Res. Select the second option and restart the Mac.

When you restart, the picture is shorter from top to bottom. The colors are much more vivid and realistic, as you’ll notice if you try to play a QuickTime movie or look at a scanned photo.

**Speeding up the IIsi**

You can get a huge speed boost from your IIsi by setting its Disk Cache (in the Memory control panel) to 768K!

The explanation has to do with the fact that the IIsi doesn’t have a video card; it uses the soldered-on 1MB of memory for both your programs’ memory and for video memory. The large disk cache forces your programs to retreat to the other, non-soldered memory boards. (A video card, of course, adds even more speed. The IIsi then won’t have to rely on the slower built-in memory for video at all).

**The 550’s secret partition**

If Apple’s programmers, in creating the Performa series, were aiming to make idiot-proof computers, they were serious about it. The Performa 550 (and similar models) is an amazing case in point. When you run the included Apple Backup program, you get a little surprise that you didn’t count on: a hidden partition on your hard drive!
This invisible chunk of hard-drive space contains a miniature, invisible System Folder. Apple's internal memo explains it this way:

"When a system problem (one that prevents the Performa from booting) is detected, a [dialog box] informs the user of a system problem. The user can choose to fix the problem manually or to reinstall software from the backup partition's Mini System Folder."

If you choose to reinstall your System software, you get the wristwatch cursor for a moment while the miniature System Folder is silently copied to your main hard-drive partition. The Performa restarts from the restored hard drive, and the invisible system partition disappears once again.

We got a Performa team member to admit that this kind of sneaky save-the-users-from-themselves approach may well be adopted in other models.

Where the names come from

It all started with the initials. There was SE, which stood for some variation of system expansion (referring to its expansion slot). Then the Mac II gave way to the IIx (an extended Mac II), the IIcx (a compact extended Mac II), and the IIfx (a fast extended Mac II). There was talk of using the same logic to name the SE/30 — it would have been called the Macintosh SEx — but we're told that the marketing folks couldn't get a trademark.

The i in llsi (slim) and llci (compact) stands for integrated video. The word Quadra refers to the fourness of its '040 processing chip. LC comes from low-cost color. And Centris? It was the center of the Mac line, and the word has that vaguely ancient-Latin sound that Apple was leaning toward for a while.
Then there’s the numbering system. When Apple product numerology was introduced, Mac purists wailed. It seemed that Apple was beginning to turn Macs into the faceless, personality-free product ID numbers common in the IBM PC world. Apple assured us that the numbers existed only to help consumers understand the power and speed differences within the Mac line.

At first, Apple seemed to be consistent. There were the PowerBooks; then, as now, the weakest model (100) has the lowest number, and the faster models (540, for example) had higher numbers. Among the Performas, the same logic worked for a while, too: the 600 was faster than the 400, and so on.

But the system fell apart with the Quadras (and subsequent Performas). Apple couldn’t go much higher than the 950 without starting into four-digit numbers, so it backtracked with the release of the Quadra 800, which actually is faster than the 950. The 840av, of course, is faster still. And with the PowerPC Macs (Power Mac 6100/60, and so on), the names get even less poetic.

The Power Macintosh Series

The Power Macs are a new breed of Macintosh — the first Apple computers built around the revolutionary high-speed PowerPC chip. Apple is deadly serious about getting these Power Macs into the world; the prices are low, easy upgrade options are available for most existing models, and Apple has promised that all future Mac models will be based on the PowerPC chip. This speed makes possible several nifty technologies, such as speech recognition and CD-quality sound recording, previously found only on the Quadra AV models.
All about emulation

To experience the exhilarating speed of a Power Mac, you have to run software specially written for its RISC (reduced instruction-set computer) processor. This special software is called native software. Every program you owned before March 1994, on the other hand, was written in a foreign language, as far as the Power Mac is concerned.

Older programs work fine — the built-in emulator program converts them to the PowerPC chip’s language in real time — but they don’t run any faster in Mac emulation mode than they would on, say, a Quadra 700. The Power Mac uses nearly all its extra speed to translate program code.

But when you run native software, no emulation/translation is required; these programs leave even the fastest Quadra in the dust. Fortunately, all the major Mac software companies have released, or soon will release, their programs for native-mode performance.

Power Mac Secrets

Use the right video jack, Jack

Most Power Mac models offer two video jacks: one on the back panel and one provided by the AV or PDS-video card. A dilemma: to which jack should you hook your main monitor for the best speed?

If you’re running native PowerPC programs, use the built-in back-panel jack for a 15 percent screen-redraw speedup. If you’re using non-native programs, the back-panel jack gives you a 35 percent slowdown. Therefore, if you’re doing most of your tasks in emulation, use the card-provided video jack.

The classic Power Mac car-crash sound

When something goes wrong on a Power Macintosh, you hear neither the four tones of a Mac II-class
machine nor the "Twilight Zone" theme of the Quadras. Instead, you hear a horrific digitized recording of a car crash.

Want to hear it for yourself without actually damaging anything? The next time you start your Power Mac, press the Interrupt switch just after the machine begins to start up. You'll hear it, all right.

**How to tell if it's a native application**
Life sure is confusing now that there are two strains of Mac software—native and non-native. Wouldn't it be nice if you could tell at a glance whether a particular program is native or not?

You can. Just highlight an application's icon and choose Get Info from the File menu. If, at the bottom of the Get Info window, you see a message about turning on virtual memory (and how much real memory you'll save as a result), you've got native software on your hands. If not, not.

**Memory savings recapped**
The most important money-saver on a Power Macintosh is the virtual-memory oddity. Turn on virtual memory, even a little bit, and each native program requires up to 4MB less memory. (Look at the Get Info box for a native program and see for yourself!)

**The much too colorful Mac**
Purchasers who laid down multiple thousands to become an early adopter of Power Mac technology were in for a fascinating surprise. On the non-AV 7100/66 and 8100/80 models, a couple of important choices are missing from the Monitors control panel—namely, any color settings below "Thousands." You read that correctly: these are the first Macs ever made that cannot be switched to black-and-white!
And you can’t switch these Macs into 4- or 16-color mode, either. The only people who’ll care are those several million Mac fans who have games and CD-ROM discs that require 16-color or black-and-white modes to run.

You’ll discover that this quirk kicks in only if your monitor is connected to the Power Mac’s extra video jack (the PDS video-card’s output), not the built-in video jack at the bottom of the case.

**Code name: LAST LAUGH**

Apple engineers have a code name for each Mac model while they’re designing it. As Apple bet more and more of its future on the PowerPC Macs, the code names for the three first models began to leak out. The least expensive one was known internally as PDM, the middle model was Carl Sagan, and the high-powered Mac was nicknamed Cold Fusion.

Meaningless, right? Not a chance. Everything becomes clear when you find out what *PDM* stands for: *Piltdown Man*. Remember that case? In 1909, an archaeologist unearthed this fossil skull in Sussex, England. For years, it was believed to be the missing link between apes and men — and then, in 1953, it was proved to be a fake.

OK. So we’ve got a hoax, another hoax (cold fusion), and ... Carl Sagan.

Well, this famous astronomer didn’t much care for the implications. He got legal. His lawyers met with Apple’s, and he wrote a couple of stern letters stating that his name was being used without permission. Apple’s legal staff promised to make its programmers change the code name of the new Mac model.

So they changed it to BHA. “Random initials,” they told the lawyers. Carl Sagan was happy. He went away.

Guess he didn’t know what *BHA* stood for: *butt-head astronomer*. 
Chapter 6
Navigation Stunts

When you double-click a document icon, your disk spins furiously at 3600 rotations per minute. Like a record player, the Mac reads information off the disk. The Mac doesn’t send this data to a speaker, however—it copies the information into memory. (By the way, we don’t belong to the “disks are memory” school. Disks are disks. Memory is memory. There’s no such thing as “disk memory.”)

By the time your memo appears on the screen, you have two copies of it: one on the disk and another in memory (RAM) on the screen before you.

Now suppose you make some changes to that memo. The version in memory is now different from the one on your disk. At this delicate stage, you have three choices. You can make the disk copy match the one on the screen—by saving it. You can make the RAM copy match the one on the disk—by using a Revert to Saved command. Or you can create a second disk copy that matches the version in RAM, so that there’s an old and a new disk copy—that’s what Save As is for.

No matter what tack you take, though, you’ll have to face the Mac’s least understandable aspect: its Save and Open dialog boxes. Here’s a survival guide.
A Tour of the Save Box

Particularly in System 7, the Save File dialog box — which appears when you choose Save As (or Save for the first time) — is loaded with hidden features. Here's our summary.

A This list shows the contents of the disk or folder identified by item D.
When you're saving a new file, the only icons that aren't dimmed are containers — disks and folders. (You can't very well store a document inside another document.)

B Item B represents a concept: there are two different places where you can type. You can type a title (C) or you can type to select a folder (A). Press Tab to jump between the two areas.

C In this text box, type the name of the file you're creating. Use up to 31 letters, but no colons.

D If you want to burrow deeper into folders-within-folders, you double-click a folder name in the list (A). To back out again, however, use this pop-up menu. It lists, in upside-down order, the nested folders you traveled to reach the location you're viewing now.

E This is the disk whose contents you're browsing. Click here to move out of the folder whose contents you're viewing, one folder level closer to the desktop.
Q. I made an alias of a folder and found in the Get Info box that the alias was 1K in size. When I moved the same alias to my second hard drive, its size ballooned to 64K! What happened?

A. Believe it or not, the size of an alias is determined by the storage capacity of the disk it's on. An alias takes up 1K on a 40MB hard drive, but 64K on a two-gigabyte drive. In fact, no file can be smaller than 64K on a two-gig drive; the larger the drive capacity, the larger its blocks. (A block is one little parking place for data — the smallest amount of space a file can consume on the drive surface, even if the file itself is smaller.)

F This button is only available when you're viewing an ejectable disk or its contents.

G This takes you directly to your bird's-eye view of the disks accessible by your Mac, including your hard drive, floppies or cartridges, and any networked drives that you've mounted.

In Desktop view, you also see any files whose icons you've dragged onto the desktop. Interestingly, you also see a dimmed icon of the Trash. (We've always wondered why it's always dimmed. We've written documents now and then that we wouldn't have minded saving directly into the Trash can.)

H Only some programs offer this button: for example, Word, Now Up-to-Date, and QuickDex do, but Claris Works and FileMaker don't.

Anyway, needless to say, it lets you create a new folder, in case you're trying to save a document for which no existing folder is quite right.

I More and more programs put specialized controls here. Usually there's a pop-up menu that lets you specify what kind of document you want to save: a text file, a Word file, and so on. That's good, because saving your work as another file type is one of Save As's most important uses.
Save and Open File Secrets

Hidden keystrokes

You should never have to use the mouse at all when you’re opening or saving a file. Here are the alternatives.

⌘-D Jumps to the Desktop level; the same as clicking the Desktop button. ⌘-Shift-↑ does the same thing.

⌘-↑ Moves “upward” one level closer to the Desktop. This is how you move from an inner folder to the one that contains it.

⌘-↓ Opens the highlighted folder or disk; the same as pressing Return or Enter.

⌘-→ Shows you the contents of the next disk. You go in the order that the disks appear on your desktop, from top to bottom. Press ⌘← to cycle through the disks in the other direction.

Without this keystroke, the only way to switch disks would be to jump to the Desktop level and then double-click a disk icon. That’s a lot of trouble.

⌘-N The same as clicking the New Folder button, if your program gives you one.

⌘-O The equivalent of clicking the Open button in the Open File box. Little-known fact: in Save As boxes, it’s also the equivalent of clicking the Save button! This bug survived through several generations of system software (it was fixed in System 7.5).

⌘-S The same as clicking Save.

⌘-  (That’s ⌘-period.) The same as clicking Cancel.
Return  (Or Enter.) This key’s effect changes, which causes some confusion for beginners. And for us. If you’re in type-to-select-a-file mode (the thick outline is around the list of files) and a folder or disk’s name is highlighted, then Enter or Return opens the highlighted folder. Otherwise, Return means Save! That often throws us. We press Enter, thinking we’re saving the file. But some folder was highlighted at the time, unbeknownst to us — and the file winds up getting saved into the wrong folder. No wonder beginners often complain that they create documents and can never find them again.

Option-double-clicking an alias
When you’re viewing the Open File dialog box, alias names show up in italics. If you double-click one, the original file (from which the alias was made) opens.

If you Option-double-click it, though, you don’t open it. Instead, you’re instantly shown the contents of the folder that contains the original item.

Stationery
Whenever you save a document in System 7-point-anything, you often find, in the Save File box, a Stationery button.
(You can also turn any document into Stationery by using the Finder’s Get Info command on its icon, and selecting the Stationery checkbox.) A document saved as Stationery doesn’t actually open when double-clicked. Instead, a perfect copy of it opens, named Untitled. The original—the master—is left safely on your disk. You can modify the Untitled copy to your heart’s content and eventually save it with its own name—and you’ve saved yourself the effort of re-creating whatever elements were already in the stationery (your logo, for example).

Anyway, we have only one Stationery Secret, but it’s a great one. Don’t you hate how, every time you save a new document from, say, ClarisWorks or Word, the Mac proposes storing it into the program folder? For beginners, and even power users, this means lost files; new documents frequently get stuck deep within some folder (such as the Word folder) instead of on the desktop or in a Documents folder, where they’d be easy to find.

Life is sweeter on the Performa or in System 7.5, where you can have all your newly created documents saved into a Documents folder. For everyone else, here’s an ingenious solution.

Create a blank document, and turn it into a piece of stationery. Call it New Word Document, New ClarisWorks Document, or whatever. Put this stationery document into the desired “magnet” folder (a Documents folder, for example).

From now on, when you want to launch that program, double-click that stationery document instead of the application icon itself! Then, when you save your work for the first time, the Mac will propose storing it in—yes indeed—the Documents folder instead of the Word folder, where you’d never find it again. Added bonus: if you had taken the trouble to set up all your margin, font, and preference settings in the blank document, they’ll all be in place for every new document you create this way.
A Word about Word Processing

It's the Number One use of a Mac, or any personal computer. Being able to rearrange text and replace pieces of it without eraser crumbs or white-out ... it's enough to draw even card-carrying technophobes into the world of personal computing.

The Mac marketplace isn't as riddled with competing word processors as the IBM marketplace is. But there are more than enough choices, from the simple to the mega-wordcrunchers like Word and WordPerfect. We actually know one woman who runs her entire office using TeachText, for heaven's sake. She's in absolute heaven.

Word-Processing Secrets

Double-click/drag and much more

The normal method of drag-selecting text is too slow, because you have to be letter-accurate when you drag:

I didn't think this year's trip would be very exciting. We weren't straying far from the house in Bowling Green, Ohio where he's
Here’s Shortcut #1: select one word by double-clicking anywhere on the word:

I didn’t think this year’s trip would be very exciting. We weren’t straying far from the

Our extra-efficiency Shortcut #2: combine these two techniques into a double-click/drag:

I didn’t think this year’s trip would be very exciting. We weren’t straying far from the

In other words, point to the first word you want included in the selection. Double-click, but keep the button down on the second click. With the button still down, drag sideways (or diagonally) to select text in whole-word increments.

Get used to this trick — in real life, you use it more often than you use simple dragging. After all, how many times are you trying to select only part of a word?

**High-speed Delete**

On a Mac keyboard used by a right-handed person, the Delete (Backspace) key is in an incredibly dumb place! Think about it: it’s at the upper-right corner of the keyboard. And where, nine times out of ten, is your right hand located just before pressing the Delete key? It’s on the mouse, especially if you’re editing. So your right hand travels back, forth, back, forth, mouse, Delete, mouse, Delete — and your left hand sits there twiddling its thumb, so to speak.
Our suggestion is to install a Delete key on the other side of your keyboard. No, this doesn’t require a soldering iron. You already have a couple of keys there that you rarely use — the tilde key (~) and Esc.

Teach your Esc key to be the Delete key. We guarantee that you’ll love this. For the first time, you’ll be two-handed: mouse with one hand, position the cursor, delete with your left hand. It’s sheer joy.

The easiest way to create this happiness is to use a macro program like QuicKeys, or like TempoEZ, which comes with the real copy of this book. Teach it to “press” the Delete key when you hit Esc or tilde.

**TRUE FACT**

**Why it’s called Sosumi**

Ever wonder about the names of the sounds that come with System 7? For the most part, they’re onomatopoetic, spelled like they sound: “Wild Eep,” “Quack,” and so on. But what about that staccato E-flat diminished triad called “Sosumi”?

Early in Apple’s career as a computer-making superstar, there was a little legal trouble. (Apple’s always in legal trouble somewhere in the world.) And that trouble was with, believe it or not, the Beatles. The Beatles’ private record label was called Apple Records. The Beatles’ lawyers claimed that Apple, in making a computer with sound capabilities, was trying to get into the recording industry, causing confusion in consumers’ minds. After all, these two companies had the same names and were doing the same things, right?

So Apple sighed and promised Apple Records, in writing, that it would never get into the recording industry. Apple Records backed off, and Macintosh went forth into the world.

A few years ago, however, Apple started including a microphone with most Mac models. And guess what you’re supposed to do with that mike? Yup — make recordings! It certainly would take a hypersensitive record company to interpret giving away a free microphone as “entering the recording industry.” But you never know. Some wily Apple engineer, recognizing the potential litigation, gave the alert sound a name that serves as a subtle tribute to Apple Records: Sosumi!
Master fractional character widths

If you want to look good in print, learn about fractional character widths.

The Macintosh screen, regardless of the make or model, uses 72 dots (pixels) for every actual-size inch. As it turns out, 1/72 inch is a large enough distance to be visible, especially in a laser or StyleWriter printout.

The problem is that on the screen, the position of every character is rounded off to the nearest 1/72 inch; that's the closest the Macintosh can come to putting it where it really belongs. For a year or two in Macintosh history, the world was filled with awkwardly (loosely) spaced words in laser printouts, as every character's position was nudged into 1/72 inch slots.

Finally, one program after another introduced the fractional widths option. When text is laser printed (or StyleWritered, or Lino'ed) using fractional widths, the printer is allowed to place each character at its typographically correct position, which isn't necessarily in a multiple of 1/72 inch. As a result, the printout is slightly tighter, looks much more professional, and no longer has those funny extra-wide spaces between words.

In Word 5.1 and WriteNow, the checkbox is in the Page Setup dialog box. In MacWrite Pro and ClarisWorks, it's a checkbox in the Preferences dialog box, as shown here:
So why not leave Fractional Widths on all the time? Because the screen display, limited as it is to $\frac{1}{n}$-inch increments, suffers. The Mac has no choice but to overlap the characters, which makes them harder to read. As a result, many people do their editing with this feature off, and then they turn it on just before printing. You could easily create a QuicKeys or Tempo macro to do this for you.

**Document security**

Here's one of our favorites. Everybody has text that's best kept private. Yet whose Mac is completely free from casual inspection by other family members or coworkers?

Here's a sneaky trick to keep your prose protected. Select the text you want to hide (below, left) — and make it *white*! Your text will appear to disappear (right).

For example, in Word, open the Character or Font dialog box and choose White from the Color pop-up menu. In ClarisWorks or MacWrite, use the Text Color command in the Style menu. For added sneakiness, type some bogus black text at the beginning, so nobody will suspect there's anything funny about your document.
Microsoft Word Secrets

Shortening Word's menus

Why keep your Word menus cluttered up with commands you never use? Removing them means shorter, more meaningful menus.

To delete a menu command, press `Option`-minus sign (use the minus sign on the main keyboard, not the numeric keypad). The pointer becomes a boldface minus sign. When you select a command, the menu bar flashes, and the item you selected disappears from the list:

```
Tools  Window  Work
Spelling...  F7
Grammar...  F6
Thesaurus...
Hyphenation...  F15
Word Count...  F15
```

You can remove multiple menu items without having to repeatedly press `Option`-minus — simply hold down `Shift` just before you remove each item. This will keep you in Remove From Menu mode so you can continue to remove commands. When you're ready to quit your menu-purge, press `period`.

ANSWER MAN

Sine qua non

Q. Oh, great. I was so impressed with your earlier section on using the Remove From Menu command in Word 5.1 that I got carried away and removed the Commands command itself. Now what do I do? I can't open the Commands dialog box to put the Commands command back on the menu!

A. Yes, you can. Even if you delete the Commands command from the Tools menu, you can still open the Commands dialog box by using the keyboard command `Option`-Shift-C.
By the way, removing commands from menus doesn't delete them from Word. To restore a command you've removed from a menu, you can reinstall it by using the Commands (Word 5) or Customize (Word 6) dialog box.

**Keyboard control in dialog boxes**

In many Word dialog boxes and windows, you can use keyboard shortcuts to select and deselect checkboxes and other options.

In most dialog boxes that don't contain a text field, you can trigger buttons by typing the first letter of the button's name—without any modifier keys:

In dialog boxes that do contain a text field, you generally have to press `Esc` as well as the first letter of the button's name, as shown here, so that Word won't think you're trying to type into the blank:
The Screen Test screen saver

You do know about Word 5's built-in screen saver, yes? It comes on whenever you choose Screen Test from your menu.

Of course, it helps if you put it in your menu first. Use the Commands command, scroll to Screen Test, and click the Add button. It appears in the Tools menu.

This screen saver darkens your screen and draws dazzling designs until you click the mouse. When you do click it, you get a dialog box listing the many different, fascinating, and colorful settings for this SpiroGraph-like screen dimmer. For Screen Test to run, you must have at least one Word document open.

TeachText & SimpleText

Ah, TeachText. It was probably the first Mac word processor you ever used. It shows one font and can only open one document at a time. But it's fine for just typing. (Remember that, PowerBook fans, when you're up against the memory wall en route to Cincinnati.)
And then there's SimpleText, which comes with all recent Macs. It's been substantially enhanced — multiple fonts and sizes can appear in a document; you can open more than one document at once; and you can record a sound with each document, if you have a microphone.

All of the following tricks apply to both SimpleText and TeachText.

TeachText/SimpleText Secrets

Edit the uneditable

When you double-click TeachText, it opens a blank document and lets you word process. But when you open a Read Me file that comes with a program, you're usually not allowed to edit it or copy from it! You can only read or print it.

There are two kinds of TeachText documents: one that can't be edited (below left) and one that can (right).

The difference is the four-letter, behind-the-scenes type code for the document. Here's how to change one to the other.

Start by opening DiskTop (included with the real SECRETS book) or File Buddy (shareware). Use its Get Info command on your TeachText file. Change the
type code to ttro (to make an uneditable document — “TeachText, Read Only” = ttro, get it?) or TEXT (to make it editable). When you return to the Finder, you’ll see your document’s new icon.

Roll credits! (TeachText only)
While pressing ⌘ and Option, choose About TeachText from the Apple menu. You get to see some additional credits.

World’s dumbest user stories, Part I
As consultants and troubleshooters, we’ve seen it all. We’ve taken the calls from people whose printer simply wouldn’t work (it wasn’t plugged in); people who couldn’t manage to stick a floppy disk into the drive (a disk was already in the drive); and people whose work disappeared suddenly and without a trace (they had clicked the desktop, sending their word-processor window to the background).

But that’s small potatoes compared to some of the stories we read in the Wall Street Journal recently. A technician at Compaq Computers told of a frantic call he received on the help line. It was from a woman whose new computer simply wouldn’t work. She said she’d taken the computer out of the box, plugged it in, and sat there for 20 minutes waiting for something to happen. The tech guy asked her what happened when she pressed the power switch. The lady replied, “What power switch?”

Then there’s the immortal tale of the help-line technician who asked the caller to send him a copy of the disk that was giving her trouble. Sure enough, several days later, the technician received a Xerox photocopy of the disk. (It was a two-page enclosure, of course, since the disk was double-sided.)

Our credulity is stretched nearly to the breaking point, however, by the following story told by a Dell computer technician. As the Wall Street Journal put it: “A customer called to say he couldn’t get his computer to fax anything. After 40 minutes of troubleshooting, the technician discovered the man was trying to fax a piece of paper by holding it in front of the monitor screen and hitting the Send key.”
Chapter 8
Troubleshooting

The Macintosh has an infinite number of cooks. There are the programmers who wrote the system software. There are the programmers who wrote the software you use. And then there's the hardware, complete with a number of additional software elements (in the ROM chips, for example), both from Apple and other companies.

With so many instructions being shouted at it, no wonder the Mac can get flustered. You may get mysterious system crashes or freezes; the blinking question-mark icon or the Sad Mac icon on startup; application, printing, or disk problems; and so on.

It's important to understand that in many cases, you never find out what caused the problem. You may rearrange the SCSI devices attached to your Mac and find the problem gone. You may change the order in which your extensions load. Or you may reinstall your system software and clear up some odd behavior you'd noticed. In all of these examples, you'll never know why you had a problem. You'll have isolated only the general area of the problem.

Still, you'll be just as happy that the problem is gone.
The SECRETS Rule of Three

Wouldn't it feel good to know a three-step procedure guaranteed to wipe out any mysterious software problems? There is such a trick. Our solution is grounded on a simple idea: your Mac worked when it left Apple’s factory! (Some of our friends chuckle at this statement. Still, we have to start somewhere.)

Therefore, our troubleshooting concept is simple: to hunt down the problem, you simply restore the Mac to the way it was when you bought it. It’s a three-step process.

Except in cases when something’s genuinely wrong with your Mac (that is, it requires a service call), this three-step process is nearly infallible.

Step 1: Turn off your extensions and control panels

The first thing you should suspect when you’re having strange system problems is the extensions and control panels you installed. These, after all, didn’t come from Apple. If you’re using System 7, this is an easy step. Restart the Mac. As it’s starting up, press the Shift key.

This simple step, we’ve found, promptly cures more than half of the mysterious system errors that plague a typical Mac.

Step 2: A “clean install” of the System

System software, like politicians and fruit, can go bad over time. Fortunately, you have an infinite supply of uncorrupted, healthy replacement copies: your system disks or startup CD.

However, the Installer program, as a convenience to you, is designed to update the existing System folder. If your
System file is already corrupted, it will stay corrupted. The only way to guarantee a virgin System folder is to perform a clean install.

In System 7.5 and later, it's easy. Run the Installer and click OK. At the main screen, press ⌘-Shift-K. You'll be asked whether you want simply to update your existing System folder (a normal install) or to install a completely new one (a "clean install"), in which case your old System folder will be renamed Previous System folder.

If you have a System before 7.5, the clean reinstall is only slightly more involved. Open your existing System folder. Hide the Finder icon by dragging it into any other folder — Preferences, for example. Then rename the System folder. (Call it "Old System folder," for example.)

The point of these two steps is to make the Installer think that there's no System folder on your hard drive; now it will build a completely new System folder.

After you've confirmed that the clean reinstall successfully restored your Mac to health, restore your customized fonts, control panels, and other customized components to the new System folder from the old one. Do so with care, however, so that you don't simply reinstate whatever problems you were having.

Over and over and over again, we've solved the weirdest problems using this technique, both on our own Macs and our friends' Macs.

**Step 3: Unplug the SCSI chain**

The equipment plugged into the SCSI port on the back of the Mac can have a huge and devastating effect on your Mac's behavior. Therefore, when you have a strange, repeating system problem, disconnect your SCSI chain from the Mac so that your SCSI port is left empty.
Q: Hey, what's the deal? I've got a completely empty floppy disk. I'm trying to copy a 100K file onto it from my hard drive, and the darned thing tells me there's not enough room! What gives?

A: Your floppy disk is full. So how come it says 0 items? Because the items on the disk are in the Trash, which is an invisible folder on the disk.

All you have to do is choose Empty Trash from the Special menu, and everything in the Trash — regardless of what disks they came from — are erased. Your floppy is now truly empty.

Other things to try

We truly believe that our three-step plan is nearly fool-proof. After all, once you've turned off your extensions, reinstalled the System, and unplugged the SCSI chain, your Mac should be pretty much the way it was when you bought it!

If you're still having some unexplained erratic behavior, here are a few more special cases worth considering.

Run a hard-drive diagnosis program

There are certain hard-drive problems that even our troubleshooting process can't solve. They have to do with the invisible files the Mac maintains on your hard drive: the Desktop files, the list of fragmented files, and so on. If these files become damaged, a hard-disk repair program may come to the rescue.

Your Mac came with such a program: Disk First Aid. It's not much, and it's not nearly as good as a commercial drive repair program like Norton Utilities or MacTools Deluxe. But Disk First Aid can indeed solve a number of these hidden disk problems. Just run Disk First Aid and click the Start button.
Zap the PRAM

Rarely (but still sometimes), the tiny bit of memory called the PRAM (see Chapter 3) gets corrupted somehow. To reset it in System 7, restart the Mac. As it's starting up, hold down the ⌘, Option, P, and R keys until you hear the second startup chord. Release the keys.

In System 6, press ⌘, Shift, and Option as you choose Control Panel from the Apple menu.

TRUE-FACT

The scoop on Performas

The Performa models of Mac are, hardwarily speaking, identical to the mainstream Macs. They differ only in what they come with: a monitor, 10 software programs, a fax/modem, and specialized system software, all for one price.

This table shows which Performa is based on which mainstream Mac; if only the last digit differs, it's because the hard drive is a different size, there's extra memory, or perhaps different software is included. ("FPU" is a special math chip used for a few scientific and 3-D modeling programs.)

<table>
<thead>
<tr>
<th>Performa</th>
<th>Based on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performa 200</td>
<td>Classic II</td>
</tr>
<tr>
<td>Performa 400-430</td>
<td>LC II</td>
</tr>
<tr>
<td>Performa 450</td>
<td>LC III</td>
</tr>
<tr>
<td>Performa 460-467</td>
<td>LC III with faster (33MHz) processor</td>
</tr>
<tr>
<td>Performa 475, 476</td>
<td>Quadra 605</td>
</tr>
<tr>
<td>Performa 550</td>
<td>LC 550</td>
</tr>
<tr>
<td>Performa 560</td>
<td>LC 550, financial software (&quot;Money Magazine Edition&quot;)</td>
</tr>
<tr>
<td>Performa 575-578</td>
<td>LC 575</td>
</tr>
<tr>
<td>Performa 600</td>
<td>IIX (minus the cache, minus FPU)</td>
</tr>
<tr>
<td>Performa 630-638</td>
<td>Quadra 630 (minus FPU)</td>
</tr>
</tbody>
</table>
Rebuild the Desktop

The Desktop file is the invisible database on every disk that stores information about all your icons. If this Desktop file gets mangled, it causes problems.

The cure: rebuild the Desktop file by holding down the Option and ⌘ keys while restarting your Mac.

The Top 10 Software Suspects

After having read literally tens of thousands of e-mails and BBS postings, we know one thing for sure: that a huge percentage of crashes, freezes, and incompatibility problems are caused by the same culprits. Over and over again, the problem turns out to be an outdated or incompatible copy of one of the following programs. Pay special attention to these offenders when you upgrade anything on your Mac, such as the system software or the Mac itself.

1. FaxSTF. For some reason, this fax/modem software seems to conflict, sooner or later, with just about everything.

2. Other fax/modem software. It's just a sensitive class of software all around.

3. ATM. Every time Apple engineers sneeze, this thing needs to be upgraded.

4. After Dark. Ditto. Before version 3.0, Berkeley Systems had worked their way up to version 2.0. That means they'd had to tweak this screen-saver to make it compatible 25 times so far. Good thing version 3 came out — what would they have called the version after 2.0?

5. Times Two. Bad news all the way around. No wonder they went out of business.
6. **Stacker.** Same problem. You mess around with the Mac’s guts enough, you’re asking for trouble.

7. **Suitcase.** With System 7.1, there’s less call for this — but be sure to upgrade to the latest version if you use it.

8. **Adobe Type Reunion.** Conflict city. Use WYSIWYG Menus instead.

9. **Super Boomerang.** Anything this powerful and complex qualifies as a suspect in times of trouble.

10. **ClickChange.** Likewise. This system colorizer/customizer is awfully neat, but practically guaranteed to cause conflicts somewhere along the line.

---

**CASE HISTORY**

**World’s dumbest user stories, Part II**

The Dumb User stories we mentioned in a previous sidebar are sad indeed, but we’ve heard tales on our own that we think match the *Wall Street Journal*’s.

For example, a Microsoft friend told us about a guy who wanted to insert one of the old-style 5½-inch floppy disks into his 3½-inch drive. Frustrated, he simply folded the disk in half — and then called tech support in disbelief when the drive would not read his mutilated diskettes.

Or this, from Aldus: A woman called the company, irate and screaming, when she learned that PageMaker had no keyboard shortcut that would translate her newsletter into French.

Hmm...38-F, maybe?
The all-new *Macworld Photoshop 3 Bible*, 2nd Edition, is the ultimate hands-on reference for artists, designers, and anyone who works with today’s leading image editing software. From Photoshop fundamentals to extensive coverage of advanced features and techniques, *Macworld* magazine graphics guru Deke McClelland covers it all. Includes a FREE CD with filters from Kai’s Power Tools, 450MB of royalty-free stock images, and more!

ISBN 1-56884-158-2
$39.95 USA/$54.95 Canada

**1.800.762.2974**
IDG Books Worldwide • 3750 North Post Road, Suite 140
Indianapolis, IN 46226 • Attn: Book Order

Name _____________________________________________
Address ___________________________________________
Phone _____________________________________________
Prepay by:   __ Check  __ Visa/MC
Account # ___________________________________________ Exp. date _______________________
Signature ___________________________________________
The Macworld Complete Mac Handbook Plus Interactive CD, 3rd Edition, is the ultimate guided tour of the Macintosh world. Need advice on what to buy? Want to master the products you have? Curious to know about the hot trends? The answers are in this book, written in the engaging style that has made Jim Heid one of Macworld magazine's most popular columnists. Plus, you get over 500MB of Hot Software and QuickTime movies on the FREE CD, including Jim Heid's "Handbook Interactive" that features 3-D animations, exclusive interviews with Apple notables, and more! 

ISBN 1-56884-192-2
$39.95 USA/$54.95 Canada

1.800.762.2974
IDG Books Worldwide • 3750 North Post Road, Suite 140
Indianapolis, IN 46226 • Attn: Book Order

Name
Address
Phone
Prepay by:  _ Check  _ Visa/MC
Account # ___________________________ Exp. date ___________________________
Signature

MINI:1294
The Best of Macworld SECRETS

Listen Up!

The newly definitive Macintosh reference work, replacing the Macintosh Bible. I'm almost embarrassed to say that [it] has kept me up at night, leafing through it in search of new tricks.

John Burgess, The Washington Post

SECRETS is fabulous! Best I've read! Insightful, humorous, educational without being boring. Every night, I read a bit more, and then-reread it. Who else would tell me how Macintosh got its misspelled name, or where the model names came from?

Bob Bender, Marion, Ohio

Based on your reassurances, I've made my first forays into the insides of my Mac via ResEdit, and can now empty trash, restart, shut down and make aliases, all without using the menus. Thanks for one of the most helpful and informative Mac books I've ever bought.

Chris Perez, CompuServe forum leader

How in the world did two mere mortals have the time and ability to compile so many tidbits in one lifetime? It's hard to read more than a few pages before I want to run over to the Mac to try out some of your secrets.

Barry Diamond, Miami, FL

You have produced by far the most informative book on the Macintosh. They can bury the so-called Mac Bible. Congratulations!

Jonathan W. Crawford, Mill Valley, CA